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1. INTRODUCTION

Thea for SketchUp is an integrated version of Thea Render. It allows you to create stunning images right inside SketchUp and work
interactively with cameras, materials, and lights.

The extension supports SketchUp Make and Pro, versions 2015-2018, on Windows and Mac OS X. We highly recommend using a 64-bit
version of SketchUp 2015 or higher, because you can then access all of the available memory on 64-bit operating systems.

2 I NSTALLATION Tr Thea for SketchUp Setup =le e
L]

Choose Components
M s Wi n doWS Choose which features of Thea for SketchUp you want to install. Cr
Download and execute the Thea for SketchUp installer from www.thearender.com. ok e orponils your Wi 1o Bl (reheek W compoenits vou Gont Wt 1

install. Click Next to continue.

Make sure you have administrator rights while installing the plug-in; right-click the DT Sesaton

installer file and select “Run as Administrator.” [7] sketchUp 2016 Plogin

SketchUp 2017 Plugin

SketchUp 2018 Plugin
Nvidia Optix Denoiser: This option requires an NVIDIA graphics card. sk

Space required: 149. 1MB
Important:
When installing Thea for SketchUp, set the path of the Thea Data and Thea Temporary |« Pz .
folders to a location where every user has full read/write access. If the path doesn't <dack || Met> | [ cancal |
have proper permissions, the plug-in won't work properly.
T Thea for SketchUp Setup ol & =)
Choose Thea Data Location
Choose the folder in which to install data for Thea Render. Cf‘

All Thea Materials, Models, temporary files will be saved there.

Setup will also install necessary data in the following folder. To installin a different folder,
dick Browse and select another folder. Click Mext to continue.

Data Folder

C:'\ProgramData\Thea Render Browse...

Space required: 40, 7MB
Space available: 69.4GB

< Back ][ Install JI Cancel

Mac 0OS X ‘® & Install Thea for SketehUp
Download and execute the Thea for SketchUp installer from www.thearender.com. CusomlnstailonghilghiSerad
Package Name Action Size
Introduction Skip 325,6 MB
. . : Thea For SketchUp 2016 Upgrade 325,6 MB
Make sure that SketchUp was started at least once before running the installer; ;‘“t”,“t_ - @ Thea For sketchup 2017 Upgrade 3256 MB
. . . . e s @ Thea For SketchUp 2018 Upgrade 325,6 MB
otherwise it won't appear in the list. Installation Type ) Nvicia Optix Denciser skip 2395 B
Installation v Upgrade 3256 MB
. . . . . sumnj :-‘:i
The installer will guide you through the necessary steps. It automatically recognizes 4
previously installed SketchUp versions and offers the corresponding plug-in
insta”aﬁon Space Required: 162 GB Remaining: 123,33 GB

Thea Data is written to "Home/Library/Application Support/Thea Render."

Go Back Continue

Altair Engineering, Inc
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3. ACTIVATION

. . . . . . [ License Wizard =@ =
After installing the plug-in, open the license wizard from the main menu:
Extensions > Thea Render > License Form. LiCense License: Not activated
Click "Register now" and complete the form to receive your license file by leard
. Register now.
email. |:| b i s
To activate Thea, click "I have my license file. Activate now" and browse to
. . . . . . I have my license file. Activate now.
your license file. Your license details are displayed at the top of the license = !
form.
Connect me to an existing license
% server on my network.
Note: If you don't activate your license, you will remain in Demo mode with [orErestor si008mzere
certain limitations.
7y Altair
. « e . Copyght 2018 A Enginerig . Al gt resrved
Demo Version Limitations
Please note that when the plug-in is not licensed, the rendered image
. . . . . A License Wizard [E=H|
resolution will be limited (1280x720) and watermarks will be added. All other S
features and functionalities are fully supported. License T a—
Wizard
m Register now.
Host 1D (Hard Disk)
B 1 have my license file. Activate now.
Connect me to an existing license
% server on my network.
[pori@hostex s200@myserver
Problems? Contact support@solidthinking.com
7y Altair
Copyrigh © 2018 AKar Engneesing . A ghtrserved

4. GENERAL LAYOUT OF THE PLuG-IN WINDOWS

Once the plug-in is installed, its name will appear in the Extensions menu:

You can also access Thea for SketchUp through the tool palette. Select 'Show [Eensions | Help

Thea toolbar' from the Extensions menu. The following toolbar will appear. |

Thea Render »

Thea Tool

Radl

Thea Browser

The user interface consists of three windows:

e’ 1o

THEA TooL WiNDOW

Thea Rendering Window

Show Settings Panel
Show Thea for SketchUp toolbar

Tools 3
Preferences

Help
Visit Thea Site
License Form

About

THEA MAIN RENDERING WINDOW

Set up cameras, edit materials,
place and edit lights, and set
preferences.

THEA BROWSER WINDOW
Insert Thea models, materials, skies,
and SketchUp components/proxies.

Tip: If the plug-in is not enabled, go to Preferences of SketchUp > Extensions to enable it.

Displays the currently rendered
image. Select engines and rendering
modes, and adjust the display,
channel, and environment settings.

Copyright © 2018 - Altair Engineering, Inc
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[“@ 5. Main WiNDOW

Control Panel

Settings Panel

Start/pause/stop rendering, save current

image, and view current progress.

# Thea Render for Sketchlj

Modify the display, rendering, channel, and
animation settings.

Control Pane!

512

OO | Presto (MC) -
Batch Rendering  Console Network |

* o mbd
| [Setings Panel ‘ x
Exposure
Highlights 80 %
Shadows 20%
150 160
Shutter 125
f-number 56
Gamma 22
Brightness 100 %
| Filtering
| Sharpness 50 %
Burn 0%
Vignetting 10%
Chroma 0%
Contrast 0%
[] White Balance (K) 6500
e
Weight 0%
Radius 4%
Optix Denoiser
| Blend with eriginal 0%
Other
| Steresscopic

Rendering Panel - "Darkroom"

Displays the rendered image with resolution
information and elapsed rendering time.
Double-click to maximize the window size.

Copyright © 2018 - Altair Engineering, Inc



5.1 ConTtRroL PANEL (IN PRODUCTION MODE)

Rendering Mode

Switch between Interactive and Production modes.

Start/Pause Button
Click Start to start the rendering

Termination Criteria

process. Click the Pause button Set the time or sample limit. Toggle Switches
(available when rendering is in Once the limit ha§ begn Toggles geometry, material, light, and
progress) to pause the rendering. reached, the rendering will proxy updates.

be terminated.

[ .

OnoO| 2 ® 0|0 €& 9 o M
®

Render Selection Render Engine Selection

Select a render engine based on the
rendering mode.

Enable to render only the
current selection.

Open/Save

Stop Button Save the current rendering as an image
and open saved images.

Stop rendering and refresh the
main window to display the
final image.

5.2 ConTRrOL PANEL (IN INTERACTIVE MODE)

Display Mode

Available when in Interactive Mode. You can choose
from several display modes for rendering in
Darkroom or in SketchUp View.

Qo |k | [pretomg < |[inSketchUpwithedges  ~|| @ € @ | imlga

Copyright © 2018 - Altair Engineering, Inc



S Altair

-+
;"JRENDER

Tro 6. THeA TooL WiNDOW

6.1. CAMERA TAB

@  f-number Pinhole =

Auto Focus

Tools Panel [z|| Resolution
G € |?® | @ Adjust the resolution of the rendered image by modifying the width and height settings. Please
note that the interactive rendering modes use the entire main window of the plug-in, and that
S they render at exactly the same resolution. The plus and minus buttons increase and decrease the
i . 5 e o m@ current resolution twofold. Toggle the portrait/landscape button to change the orientation of the
TN .
—— rendered image.
e Aspect Ratio
Projection _ This setting controls the proportions of the final rendered image.
e 21 su Window - Use the same aspect ratio as the model view in SketchUp.
Thea Window - Use the current proportions of the main render view.
4:3 - Use for older monitors with a resolution of 800x600, 1024x768, or 1600x1200.
Depth of field 16:9 - Use for newer wide screen monitors with a resolution of 1600x900 or 1920x1080.
Sharpness 2% 2:1- Use when creating a panoramic spherical or hemispherical image.

Lens
P el 100 [ucten Projection: Select Standard to project the rendered image in the same way as in SketchUp
Stereoscopic (Presto) 1| (perspective or orthogonal), or choose from Spherical or Cylindrical projection. Spherical
Eyes Distance (cm) 60| projection creates panoramic renderings that can be viewed in external programs; the correct
aspect ratio for a spherical image is 2:1.
Z'c"""i"g_ Shutter speed (motion blur): You can reconfigure the diaphragm of the camera by selecting
e Near_D'mce Y between Circular or Polygonal and defining the number of blades. This influences depth of field
[T] Far Distance 1000.00 .
and motion blur.
’ Level camera ] Depth Of Field
Adjust the depth of field either by modifying the 'f-number' of the camera lens or the Sharpness
General

% (percentage of blurriness of the rendered image).

LIz s s Enable 'Auto Focus' to automatically bring objects 'in focus' when possible. To display the manual

Colla focus distance, click the 'Set' button and select a point on the model; this value is ighored when
Soene SeTiRg 'Auto Focus' is enabled.
[¥] Camera [¥] Sky/TBL Z-C“ppiNg
[¥] Display [¥] Render You can enable Near Distance or Far Distance vertical clipping by entering the distance in meters.
This way you can create vertical cuts that, for example, let you see inside a room without having
to cut a wall.

Level Camera
Click on this button to level the camera without changing its position, which is especially helpful when creating a panoramic image.

Scene Settings

This lets you associate the Thea Render settings with SketchUp scenes/pages. It works the same way as the scene setting do in SketchUp--
they are loaded automatically when a scene is selected. To save the settings, select the scene name from the list, select the setting types
you want to save, and click the 'Save' button.

Available options are: Camera, Display, Sky/IBL, and Render settings. A green dot indicates the scene contains the setting.

You can easily remove settings from selected scenes by clicking on a green dot and selecting 'Clear selected,' or remove settings from all

scenes by selecting 'Clear all.'
Scene Settings

| View 01 -|

s
7] Sky/TBL

Clear selected ¥
E Render

Clear all

Copyright © 2018 - Altair Engineering, Inc
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6.2. MATERIAL TAB

Tools Panel : B In the Material tab, you can click Preset or Editor.
(o N N | @
: Material Preview
preset () = pator You can see a preview of the material in the top left of the Material tab by selecting either
pEth e | Defaut Preset or Editor. The preview updates as you make changes. To view a full-size preview,
== W e double-click the image.
Reflections 03 Lacquer
Roughness 0% Wila Ceramic
r Car Paint
Bume R e Presets
. This option allows you to quickly transform a standard SketchUp material into a Thea material
Glass through a simplified interface.
Cloud
Emitter

You can choose from a list of ready to use materials like Metal, Car Paint, Glass, etc. Next to
'Default Preset,’ click the hamburger menu icon, and then click a material.

Loading & Saving Thea materials
Thea Materials can be saved as .mat.pack and .mat.thea files. Right-click on the material
preview area and select Load or Save Thea material.

.mat.thea: This file type includes only the material description, without any bitmaps.
.mat.pack: This file type includes the material description, bitmap files, and material preview.

Customize a Preset Material
At the far right of a channel (Color, Reflections, Roughness, etc.), click the icon to choose from the following

options: —

eSketchUp: Use the color defined in SketchUp's material tray.

eColor: Select a custom color. 0% wedlag
*Bitmap: Select a bitmap texture. You can preview the bitmap texture and edit the parameters (Tonemapping, 2% ="
UV Editing, etc.)

Editor

Tip: When switching from the Editor back to Presets a small popup will ask you whether you want to reset back to a default preset, making
sure that you haven't accidentally clicked on it and lose your material modifications.

DEFAULT THIN TRANSLUCENT LACQUER CERAMIC CAR PAINT COLORED METAL MIRROR THIN GLASS GLASS

CLOUD EMITTER

Thea Cursor

When the Thea Tool window is open, the SketchUp cursor changes to the Thea cursor, indicating that you can click on a face _|_

to pick the corresponding material for editing. The Thea Cursor can also be used to select and edit Thea Lights from the t r
]

scene.

Tip: When rendering interactively in the Thea Window, the cursor changes to a cross-hair, indicating that you can select a material directly
in the rendered image. Click once to open the Material tab and display the material properties.

Copyright © 2018 - Altair Engineering, Inc
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Preset ‘: = Editor
LY &=

@ Coating 100 %

o, I
| Basic Layer Properties
] Diffuse

Reflectance

Index of Refraction (M)

Extinction Coefficient (K] 200

Roughness

Bump

: Diffuse Properties

R: 200
G 30
B: 25
EE
SO
Ve 200

' Editor
| Use the full material editor to create a complex material with multiple layers.

Layers

| You can create multiple layers of different types and weights.

eCreate a layer: Click the plus (+) icon, and then click a type of layer (choose from Basic Layer, Metal
Layer, Glass Layer, Thin Glass Layer, or SSS Layer).

eChange the type of layer: Click the sphere icon, and then click a type of layer (choose from Basic,
Metal, Glass, Thin Glass, or SSS).

eDefine the weight of the layer: To change the %, drag the colored horizontal bar. Or to select a
bitmap, click the checkerboard icon.

eDelete a layer: Click the layer, and then click the trash can icon.

eMove a layer: Click the layer, and then click the up or down arrow.

Material Preview

The material preview can be maximized by double-clicking on it. More options can be found when
right-clicking on the preview:

eLoad Material: Loads a .mat.thea / .mat.pack Thea Material.

eSave Material: Saves the current material to .mat.thea / .mat.pack files

*Room Selection: Select between different kind of room previews (e.g. cloth, direct, floor, etc)

Material formats explanation

.mat.thea: This material file format contains the definition of the Thea Material but not the textures
used.

.mat.pack: Same as the .mat.thea format but packs all the textures in it.

Tip: Use drag and drop between channels with the left mouse button to copy a bitmap, color or procedural.

Layer Properties

- [ 3] [ F &h

Below the Layers section, you can find the parameters of the currently selected

layer. o, I -
. . . Basic Layer Properties |
Display advanced parameters: To display advanced parameters (Translucency, Micro o I0R(n) + (k)
nruse
Roughness, etc.), click the hamburger menu icon. Translucent
Reflectance Absorption (1/m)
Index of Refraction (M) Anisotropy/Rotation
Tip: Holding down the Control key in the keyboard allows you to select multiple Extinction Coefficient (K) Micro Roughness
Opt'lons. ] Translucent Standard Roughness
Roughness Linear Roughness
Bump
| Translucent Properties

Copyright © 2018 - Altair Engineering, Inc
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Stacy_Skin -

Preset (7 = Editar
=

J Basic
Coating Layer Properties =i

I Reflectance
Roughness

Bump

Reflectance Properties

Stacy_Skin -

22 Editor

Preset brzz
=

Basic Layer Properties =
Diffuse

| Reflectance
Roughness

Bump

Reflectance Properties
[—————— -
R: 255

B € |°*
Stacy_Skin -
Preset

=2 Editor
=

&

=

Layers . @
- N

Metal Layer Properties =

I Reflectance l:‘
Index of Refraction (M) 1.5
Extinction Coefficient (K) 5.00
Roughness 0% :
Bump 20% W
Reflectance Properties =
G €& ¢

Stacy_Skin -
Preset (-2 \7/' Editor
=
Layers

e n

Glass Layer Properties =i
| Transmittance

Absorption (1/m) 0

Roughness

Bump

Transmittance Properties =

Coating Layer
The coating layer uses a special reflection model with only the specular component. It is useful for
simulating varnishes and paints on a layered material.

You can use several coating layers to simulate multiple varnishes and paints. The coating itself reflects
some light, while any layers of material underneath absorb the rest of the light.

You can change the Extinction Coefficient to modify the reflectance (based on Fresnel equations) and
define the absorption density of the layers of material underneath. Both the Extinction Coefficient and the
Thickness of the layered material are used to calculate absorption at a microscopic level.

Basic Layer
The basic layer consists of a diffuse, translucent, and Fresnel based specular component. It is a highly
energy efficient material designed to be used mostly for matte and plastic materials.

You might also use basic layers to create metals and translucent materials. Metals, in most cases, have a
non-zero extinction coefficient, which corresponds to a high Fresnel coefficient under any viewing angle.

Metal Layer
You can create a metal with perfect reflection (Roughness = 0), a very rough metal (Roughness = 100), or
something in between.

The Bidirectional Scattering Distribution Function (BSDF) uses Fresnel equations for reflections, which is
controlled by the index of refraction and the extinction coefficient.

Set the Index of Refraction to around 1 to make the material less reflective. As you increase the value,
reflection becomes stronger and stronger; at very high values, the reflected light takes on the color of the
selected color.

Use a non-zero value for the Extinction Coefficient to amplify reflection.

Glass Layer
You can create a glass with perfect reflection and refraction (Roughness = 0), a very rough glass (Roughness
= 100), or something in between. The Bidirectional Scattering Distribution Function (BSDF) uses Fresnel

| equations to balance reflection and refraction, which is controlled by the index of refraction and the

extinction coefficient. Set the Index of Refraction to around 1 to make the material less reflective and more
refractive. Set the value to exactly 1 to make the glass perfectly transparent. As you increase the value,
reflection becomes stronger and stronger; at very high values, the reflected light takes on the color of the
selected color.

Tip: To achieve perfect transparency, we recommend that you create a Thin Glass Layer instead of a Glass
Layer with Transmittance enabled and the Index of Refraction set to 1.

Important: Fresnel coefficients are based on both the index of refraction and the angle of incidence. Even
with a very small index of refraction, the BSDF will be quite reflective for grazing angles. A real world
example is a swimming pool. When you look straight into the pool, the water is transparent; however, when
you look at the pool from afar, the water reflects the environment.

Copyright © 2018 - Altair Engineering, Inc
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| @ | @ Thin Glass Layer
| Stacy.Skin .| This glass model describes thin glass materials that show perfect (mirror) reflection and transparency.

- Pret @ 2 Eder ' Thin Glass models are very accurate models and are great for assigning to thin surfaces, such as windows
| & (@ ¢ ' and thin transparent plastics. Although you could also use a glass material with transmittance enabled
and index of refraction set to 1, it is recommended to use the glass model whenever you want to achieve

. [EEGEENEGE 5| transparency.

Thin Glass Layer Properties =|
|:a""”‘“a"‘e e D “| Another way to achieve transparency is to actually model a surface, such as a window, as a thin double

ump

interface where refraction takes place at both sides. Using the glass model though is optimal in terms of
visual accuracy and additionally, it can be traced during shadow evaluation (something like this cannot be
done with the double interface model which will create shadows). The glass model does not assume the
model to be closed as it does not define an interior/exterior volume. The index of refraction is used as if
the model was a double interface, in order to compute the overall transmittance due to double

Transmittance Properties =

refraction.
(& e @ & SSS Layer
' | [Stocy,Skin . The Bidirectional Subsurface Scattering Distribution Function (BSSDF) is a generalization of the

Bidirectional Scattering Distribution Function (BSDF); however, unlike BSDF, the entry and exit points for
BSSDF may differ instead of coinciding. Therefore the evaluation of BSSDF is far more difficult, as it

Preset (9 = Editor
&=

| & [ : . : involves the interaction of surface reflectance/transmittance along with scattering through participating

media.

o [EEseE] S| Besides the surface reflectance entries, there are also parameters describing absorption and scattering
SSS Layer Properties =| inside the object. In order for the SSS material to be evaluated correctly, the object should be closed
Ee=arptentlin) w []# (without holes).

| scattering o [ o

Reflectance l:‘ =

e o B Participating media with high albedo (i.e., when the scatter density is much higher than the absorption
Bump w% nu| density) are particularly difficult to render. To accelerate rendering with minimum loss of accuracy,
usually you can turn an asymmetric medium into an anisotropic medium with a synchronous decrease of
its scatter density. Assuming that the asymmetry of the medium is g > 0, you can set asymmetry to the
isotropic value of 0 and decrease the scatter density to a value that is equal to the old scatter density
multiplied by 1-g. The new medium will have lower albedo, and it will render faster with minimum loss of
accuracy.

Scattering Properties

— —————— r

Copyright © 2018 - Altair Engineering, Inc
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LAYER PARAMETERS

Diffuse: Diffuse reflection is when light is scattered at several angles on a surface. You can select a texture, color, or procedural.
Layers used in: Basic

Reflectance: Reflectance is the texture for the specular component when you view the surface from directly above. Reflectance at the
grazing angle (90 degrees) is also implicitly defined. So, the specular reflectance is calculated as a combination between user Reflectance
and Reflectance 90 (white by default), depending on the viewing angle.

Layers used in: Basic, Metal, Glass, SSS, and Coating

Anisotropy: Stretch and blur highlights against the grain of the material, which is particularly useful for metals. For no anisotropy, set the
value to 0%. For full anisotropy, set the value to 100% (the material is a perfect reflector/refractor in one direction and completely rough in
the other direction).

Layers used in: Basic, Metal, Glass, SSS, and Coating

Rotation (deg): To rotate the stretched and blurred highlights created using Anisotropy, enter a value from 0 to 360 degrees or select a
texture.
Layers used in: Basic, Metal, Glass, SSS, and Coating

Roughness: Adds texture to the material at a microscopic level, affecting specular reflectance and transmittance. 0% creates a perfect
mirror reflection. Lower values produce crisper and brighter reflections. Increasing the roughness will spread and distribute reflections
and create a more matte surface. Higher values produce bigger highlights and reflections that are more blurry and dim. At values
approaching 100%, light becomes so scattered that the reflections are barely visible, if at all.

Layers used in: Basic, Metal, Glass, SSS, and Coating

Bump: Adds texture to the material at a macroscopic level. A bump map gives the illusion of texture without physically distorting the
geometry, minimizing rendering time. Each layer of material can have its own bump map. The grayscale map tells Thea Render how to
change the surface normals as if the surface has been displaced; the modified normals are used in lighting calculations. A bump map looks
like the inverse of what you might expect: black represents the highest extreme and white represents the flattest extreme, while shades of
gray represent grades in between.

Layers used in: All

Normal: This is a more detailed version of bump mapping, where you select a RGB color image instead of a grayscale image. While
standard bump mapping uses grayscale values to describe the surface's hills and valleys in terms of height, normal mapping translates red,
green, and blue values to x, y, and z coordinates. This creates texture in terms of normal vectors up the hill or down the valley. Specifically,
the red, green, and blue values (0 to 255) are translated to x (-1 to 1), y (-1 to 1), and z (0 to 1) coordinates respectively.

Layers used in: All

Index of Refraction (n): When you place something behind a transparent object, it becomes distorted. The level of distortion is
determined by the Index of Refraction, which defines how much light is bent and reflected when it comes into contact with a transparent
surface. For example, air's value, 1.0, causes no distortion of background objects. A value of 1.5 means that the background objects
become considerably distorted (e.g., a glass marble). A value just below 1.0 causes the object to reflect along its edges (e.g., a bubble seen
from under water).

Layers used in: All

Extinction Coefficient (k): This refers to light that is likely to be lost (i.e., to absorption and scattering). The higher the extinction
coefficient, the more opaque the material. You can use a value of zero or above.
Layers used in: Basic, Metal, Glass, and Coating

Translucent: Make the material semitransparent by clicking on a texture. If no texture is selected, then no translucency will be rendered.
Layers used in: Basic

Micro Roughness: Adjust the sharpness of reflections, as the viewing distance goes from near to far. When looking at a surface that is
completely rough, planes that are closer appear rougher (because you can see them more clearly) while surfaces that are further away
appear smoother (because you can't seem them as clearly). You can adjust the Height and Width to define the average height and width
(um) of the bumps on the surface.

Layers used in: Basic, Metal, Glass, SSS, and Coating

Copyright © 2018 - Altair Engineering, Inc
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Thickness (um): This refers to the coating thickness. The thickness and extinction coefficient are used to calculate the amount of light
absorbed by any layers underneath the coating.
Layers used in: Coating

IOR File: You can create a physically accurate material by using an Index of Refraction file, which provides the exact index of refraction and
extinction coefficient for each wavelength of a material. The file extension is .ior or .nk.
Layers used in: Glass and Metal

Transmittance: The amount of light that passes through a material.
Layers used in: Glass and Thin Glass

Absorption (1/m): Change the absorption density and color. You can use a value of zero or higher. The higher the density, the more
absorptive the material.

Note: In the Basic layer, Translucency needs to be enabled for Absorption to take effect. For glossy materials, you need to select a color or
a texture for transmittance first.

When the absorption values is greater than zero, a value in millimeters will be displayed. This value represents the distance that the
absorption color will be visualized.

Layers used in: Basic, Glass, SSS, and Coating

Abbe Number: Can be used to create a rainbow effect in the interior of an object, such as a gemstone. Without this rainbow effect,
gemstones would look like glass. Lower values correspond to a stronger rainbow effect. Increase the value for a more subtle effect. You can
look up the values for specific materials online. The Abbe number describes the variation of the index of refraction with respect to the
wavelength.

Layers used in: Glass

Interference: Makes a surface iridescent, simulating a phenomenon called thin film interference. You may have seen this in soap bubbles,
oil slicks on water, or peacock feathers. When light waves come into contact with a thin film, some waves are reflected from the top
surface while others penetrate the film, hit the bottom surface, and are reflected. When these light waves interact, momentary streaks of
color result. The iridescent colors change when the viewing angle is changed. Adjust the Thickness to change the iridescence level. 200-
1000 is a good general range for making a visible change.

Layers used in: Thin Glass

Scattering (1/m): Changes the scatter density and color for a subsurface scattering material. You can use a value of zero or higher. Note
that the higher the value, the longer it will take to render the material. The scatter color is used for both in-scattering and out-scattering
light interaction.

Layers used in: S5S

Asymmetry: Controls the asymmetric coefficient of a subsurface scattering medium, which follows the Henyey-Greenstein phase function.
You can use a value between —1 and +1, where —1 corresponds to a perfect back scattering media, +1 to a perfect front scattering media,
and 0 to an isotropic media.

Layers used in: SSS

LAYERING SCHEME

The Layering Scheme area displays all layers of the material. In addition to obtaining basic
information in this area, you can also perform several tasks.

When you select a layer, the icon to the left is highlighted in blue and the horizontal bar is displayed | © iy e
in dark gray. To move a layer up or down, click the layer, and then click an arrow. () _
Basic Layer Properties =
The gray bar in each layer shows the assigned material (metal, basic, etc.) and the layer’s weight | Diffuse . 3
with respect to the other layers. Reflectance D 3
Index of Refraction (M) 1.50
Tip: Drag the layer’s bar to increase or decrease the layer’s weight. Extinction Coefficient (K) 2.00
Roughness 35%
You can change the type of the layer at any time (without losing the assigned textures, colors, and | Bump LLbEs

values) by clicking the icon at the left and selecting a different layer type.
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MIXING LAYERS

You can mix layers vertically by adjusting the Layer Weight for each layer.

Keep in mind that the layer weight influences a material from top to bottom. This means that if

the topmost layer has a weight of 100%, then any layer underneath it will not be considered by | @ Coating
the engine. - _ ¥ _'I‘-,’;"
| B j Basic =
For example: l p W Metal ‘
We have created two layers. Layer A has a weight of 25% while Layer B has a weight of 100%. The [ o ) Glass &
stacking order plays a significant role. ; ST 2
B@ sss 200
Layer A on top of Layer B ] :
The final material will use 25% of Layer A and the rest of the weight (75%) for Layer B. Burp

Layer B on top of Layer A
The final material will use 100% of Layer B.

Note: The layer positioned at the bottom of the layering scheme always has a layer weight of 100%.

WORKING WITH LAYERS

To add a new layer, click the + icon. The new layer will be created on top of the Layering Scheme.

To remove an existing layer, click the layer, and then click the X icon that appears to the right.

To move a layer up or down, click the layer, and then click the Up or Down arrow to the left.

To change the type of layer, click the layer, click the blue icon to the left, and then select a layer type in the dialog.

Tip: When you switch between different layer types, any assigned texture, color, or value will carry over to the selected type.

LAYER WEIGHT

For each layer in the Layering Scheme, you can define the weight (%) of the selected layer
with respect to the other layers.

Basic 100 %%

All layer weights are normalized according to their sum, so that each layer’s reflectance is
modified by a relative percentage. Without any weights, layers are again normalized to reflect with the same weights.

The weight of the coating layer actually modifies the percentage of light that is allowed to reach the layers underneath.
To adjust a layer’s weight, drag left or right to increase or decrease the value.

You can also load a texture that will be used as a mask for the rest of the layers, which is helpful for creating advanced materials.

Copyright © 2018 - Altair Engineering, Inc



:’JRENDER L: Alta”

Parameter Properties Difuse Properties E
The parameter properties can be found below
the Layer Properties section.

Diffuse Properties =

Color: Use the color selector to define the RGB
values of the color.

Spectrum: Use the color spectrum mode to
define the RGB values of the color.

Color Properties H

Bitmap: You can use tonemapping (Gamma, = - fexturePropertics oo A - mm’ Low Color !&r

Saturation, etc.), change the projection, and mix = = e . | i‘ i : Wil iettn &
. . < Coordinates | ; : Octaves 1

the bitmap with a color. — o

Temperature 4933 ] Turbulence

Procedurals: Procedurals have their own

customizable settings.

E M ITTE R Toals Panel “

Thea Render supports both area and point light emitters. The area emitters are applied to a (@ ¢ [v ]|
surface. Typically, the area emitter has a diffusion-like emission model and distributes light .
evenly in all directions. Nevertheless, more complex emission models can be defined using preset (1) 2 Editer

an IES file. [&]e (0220
2 @  Standard Emitt
Color: You can define the color of the light using the following options: Color, Custom Color, || co (@ esemive
Temperature, Bitmap, and Procedural. Poer 1200.00 | Watts ] Eficay
[] Passive Emitter Ambient Emitter
§ . Custom Evaluations
Power: Define the power of the emittance. Color Properties =

o
R: 255
G: 255

Passive Emitter: The emitter will not cast light into the scene, but it will glow.

IES Emitter
To convert a standard emitter to an IES emitter, click the hamburger menu icon and select IES Emitter.

Efficacy: Maximum efficacy is 683 Im/w, which corresponds to light with no energy loss (all power is converted to visible light).
Custom Evaluations
Custom Light Evaluation allows the user to select which components (such as Diffuse, Translucent, Reflectance, Transmittance, and SSS) will

be evaluated for a given light, thus removing unwanted contributions and accelerating render times.

In the following example, we are changing the Custom Light Evaluation properties of the light on the left.

Default Diffuse: Disabled Translucency: Disabled Reflectance: Disabled
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Transmittance: Enabled

Preset t- ﬁ Editor

|0 | =2 0

v
Texture
Texture Properties =

~ Texture Properties

Filename  1ces/Personal/noise_basecolor.png [0

Clip Mapping Window

Medium: Enabled Medium: Disabled

Transmittance: Disabled

CLIPPING

Used to make areas of the material transparent, using a grayscale
texture map where black represents complete transparency and
white complete opaqueness. This is useful for quickly creating
perforated materials like a mesh, since you can skip modeling the
holes by hand.

Texture: Select an image. Colored images will be mapped as
grayscale.

Soft Clipping (Default): Softens the contrast between complete
transparency and opaqueness. The alpha channel of the image is
respected, and all gray values are used to clip the material.

Soft ping

Hard Clipping: Increases the contrast between complete
transparency and opaquness. When used in combination with
the Threshold parameter, you can select which parts of the §
image are used to clip the material.

Threshold: Changes how the texture map is interpreted. For
example, at a value of 50, 50% gray is interpreted as 50%
transparent. To make a larger area of the texture transparent;
increase the threshold; to make a larger area of the texture
opaque, decrease the threshold. At 100, all of the texture is
transparent; at 0, all of the texture is opaque.

Hard Clipping with 5Thresho|d

Hard Clippi with 3 Threshold

14
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Preset () == Editor
“ e L _

Displacement
Subdivision (16) 4
Height (cm) 0.03
Center 0.50
Mormal Smoothing

[T] Tight Bounds

Displacement Properties =

+ Texture Properties

File name ot Grid_height.png

Displacement Tab

' DISPLACEMENT

Use Displacement to create surfaces with a greater sense of depth and detail, showing self-occlusion,
self-shadowing, and silhouettes.

Note: Displacement increases rendering time significantly compared to other texturing techniques
because it creates a large amount of additional geometry.

Displacement: Select an image. Like bump maps, displacement maps are grayscale; black means zero
displacement and white means maximum displacement (a value you define using the Height

parameter below).

Subdivision: Control the number of subdivisions the object has before displacement. Higher values
produce more accurate results.

Height (cm): Used to set the maximum distance displaced. For displacement to appear, the values

| must be greater than zero.

Center: Invert displacement. This is useful for positioning objects along a ground plane. For example,
adding a displacement map to a carpet makes it appear to be floating. Reducing your center will
bring it back to the floor. Or, adding a displacement map may result in objects intersecting with the
floor. In this case, you could increase the center to avoid intersection.

Areas with black mean no displacement, and areas with white mean 100% displacement
(corresponding to the height you have given). If you change the displacement to 0.5, then the 50%
gray color in the displacement will represent no displacement, and when it is set to 1, then 100%
white will represent no displacement (it will displace the opposite way).

This inverted displacement is sometimes useful, the ground plane displacement where you want to
avoid intersecting with objects that are on the ground, for example a car wheel that is on a displaced
ground, so in this case you would set the center to 1.

Normal Smoothing: Enable to render models with smooth edges. Disable to render models with
sharp edges (box, plane, etc.).

Tight Bounds: Enabling this option computes more precise bounding volumes for the displaced
surface, leading to slightly faster rendering times. However, initialization may take longer.

Tip: A good mesh topology helps displacement work as expected. A pre-subdivided surface in the

Height set to 0.03 Height set to O.
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Absorption Color S a®

Absorption Density 10000 L

Scatter Color @ ®

| scatter Density 10000 55
Medium Tab

Thin Film with |um Enabled

MEebpium

True volumetric scattering is supported. Thea Render can solve light transport problems that include
participating media. There are a lot of possibilities since mediums can be both homogeneous. Many
phase functions are supported.

Absorption Color: Defines the transmittance color--this is actually the color visualized after a
distance of 1 meter (assuming unit density and no scattering). When the distance is less than 1
meter, the color shifts toward white. When the distance gets bigger, the transmittance shifts toward
black. The color change with distance is strongly non-linear; thus, it is recommended to avoid highly
saturated colors.

Absorption Density: Defines the density of absorption in 1/m units. The higher the value, the higher
the absorption. You can select a procedural texture in order to define spatially varying absorption
(heterogeneous medium).

Scatter Color: Defines the scattering color--this is the color that bounces off of particles in the
medium. The sum of absorption and scatter color, multiplied by their corresponding densities,
defines the extinction coefficient of a medium, which is used to calculate the total absorption at a
distance. The scatter color may be applied numerous times for particles that bounce inside the
medium (especially for a highly scattering medium); thus, it is recommended to avoid highly
saturated colors.

Scatter Density: Defines the density of scattering in 1/m units. The higher the value, the higher the
scattering. You can select a procedural texture in order to define spatially varying scattering
(heterogeneous medium).

Phase Function: Defines the variation of outgoing radiance over the sphere of directions. The phase
function is the medium analog of a bidirectional scattering distribution function (which is used for
surfaces). The available functions are Isotropic, Rayleigh, Mie Hazy, Mie Murky, Mie Retro or Henyey
Greenstein (you can also set the asymmetry value below it). Most used phase functions are Isotropic
and Henyey-Greenstein.

Assymetry: Defines the asymmetry parameter of the Henyey-Greenstein phase function. This
parameter is unitless and takes values from —1 (totally back scattering) to 1 (totally front scattering).
The extreme values of —1 and 1 do not actually scatter light outside the particle direction and they
are not of practical use. A value of 0 is balanced scattering between back and forth directions and it is
the same as using an isotropic phase function.
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TEXTURE EDITING

Tools Panel =]
G €& @
-
Preset ;: Editor
£
Layers ]
o Bmc 0%
Basic Layer Properties =
I Diffuse
Reflectance |:|
Roughness 10 %
Bump 36 %
Diffuse Properties =
Texture Properties
File name  te_01/concrete 01_diffuse 001.jpg
Projection uv ~
UV Channel 0 -
Channel RGB hd
Interpolation Trilinear hd
Repeat
Tonemapping
] Invert
Gamma 0
Saturation 0
Brightness 0
Contrast 0
Clarp Min 0%
Clamp Max 100 %
Coordinates
Offset X 0.0
Offset Y 0.0
Spatial Size 1.00
Spatial Size X 1.00
Spatial Size Y 1.00
UV Scale X 1.00
UV Scale Y 1.00
Rotation (deg) 0

Editing Modes =
The texture editing tool has two modes to work with, Overview ]
Mode and Edit Mode.

Overview: Only the modified parameters are displayed; the rest are
hidden Mic with a Color

@ | Overview Mode

Edit Mode

Edit: All available parameters for bitmap editing (Texture Properties,
Tonemapping, and Coordinates) are displayed. B ‘ \
Any parameters modified here will be displayed in Overview Mode.

Editing a Bitmap

By default, the Thea Material editor is in Overview Mode, displaying only the path to the file
and any modified parameters. To start editing the bitmap, click the hamburger menu icon and
select Edit Mode.

Texture Properties

Projection: Press the down arrow, and then select a projection for the selected texture: UV,
Cubic, Cylindrical, Spherical, Flat, Front, Shrinkwrap, Camera Map, Cubic (Centered), and Flat
(Centered).

UV Channel: You can link a texture to a channel (e.g., Diffuse, Refraction, Bump, etc.).

Channel: Two main channels exist for a texture, the RGB channel and the Alpha channel.
Interpolation: Select a type of interpolation for the selected image: None, Bilinear, or Trilinear.

Repeat: Force the bitmap texture to tile in all directions.

Tonemapping

Invert: Invert all the colors of the texture to their complementary colors.

Gamma: Use a value from -100% to 100%. In the next images, you can see how the gamma
affects the appearance of the texture.

Saturation: Use a value from -100% to 100%. In the next textures, you can see how two
extreme values for saturation affect the tone of the texture.

Brightness: Use a value from -100% to 100% to control the tone of the texture. A brightness of
-100% makes the image completely black.

Contrast: The contrast of the texture.

Clamp Min and Max: Specify the minimum and maximum clamp of the selected texture. RGB
colors normally range from 0 to 255. By setting, for example, the minimum clamp to 20%, the
colors with RGB values less than around 51 will be “cut” and get this value. By increasing
minimum clamp percentage, the image turns whiter, while decreasing the maximum clamp
percentage results in darker image colors. By decreasing the maximum percentage and
increasing the minimum at the same time, textures tend to appear grayer, as gray colors has
RGV values around the middle of the 256 colors (128, 128, 128).

Coordinates

Offset X and Y: Offsets the bitmap over the x- or y-axis.

Spatial Size (X and Y): Spatial size is used to correctly account for scaling when changing from
UV to cubic coordinates, while UV scaling affects the scaling once UV projection is used.

UV Scale X and Y: Scales the bitmap over the x- or y-axis.
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TEXTURE LAYERING

Textures can be layered and blended together to generate
complex results using any bitmap, color or procedulars as
layers.

To start layering textures, select a channel (Diffuse,
Reflectance, etc) that has a color, bitmap or procedural
assigned to it, and from the Channel Properties panel, click
on the hamburger icon and select "Mix with a ...".

After clicking on the 'Mix with a.." option, you will see the
two texture layers one on top of the other. Deleting and
moving layers is exactly the same as in Layers.

Each layer (except the one that is at the bottom) has two
blending modes. Multiply and Add. You can switch between
them by clicking on the icon.

Multiply uses the * icon while Add the + icon.

When the blending mode is in Add mode, it is possible to adjust the layer percentage.

I Diffuse

Reflectance
Roughness

Burmp

Diffuse Properties

Mize with ...

@ | Overview Mode
Edit Mode

& Color
«i  Bitmap

Procedural

Basic Layer Properties
I Diffuse

Reflectance

Reughness

Bump
Diffuse Layers

#2

Diffuse (#1) Properties

~ + I

R: 212

G: 212
B: 212
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6.3. LIGHTS TAB

SketchUp doesn’t have native light sources. Thea for SketchUp uses components with special

5| @ s
names to define the position and orientation of lights. Four light types are available:
Mame: [thea_spotlight VI . .
e PrOJ.ector nght
| Projects an image

Power 300 [Watl's ']

S 2| point Light P

faoson [Inverse Square *| Radiates light

- Temperture (9 P equally in all gt IES Light

Spotlight options directions Casts a cone of light from a An IES file is a digital profile of a real world light. It is

Hot Spat 30 specific location, in one direction useful for simulating physically accurate lights. You

Fall Off 45 can find free IES files online.
You can also apply an Emitter material to a face to create an indirect source of illumination. The
front side of the face will glow.
Creating Lights
To create a light, open the Thea Tool window and select the ‘Light’ tab. Click on one of the
buttons at the bottom of the tab to create a point, spot, IES, or projector light. Right-click to place
the light source, and right-click again to place its target. For point lights, only the distance from
the source to the target is used to calculate the power needed to reach the target. It is important
that the distance between the light source and any adjacent geometry is greater than the radius
of the light; otherwise, the final rendering may contain undesired “noise.” Once created, the

e = light's name and properties are displayed in the Light tab.

[#] Enabled

i::’::;if °::i)us(mJ . Tip: If a light looks faint in the rendering, check the exposure settings (ISO, Shutter speed, and f-

"~ | number). For interior scenes, respective values of 800, 30, and 2.4 are usually sufficient.
Create lights

R EYENEY

General Properties

General =
Enabled: Turns the light On/Off. [¥] Enabled T v | Container
[¥] Shadow (BSD only) v Custom Evaluations
[7] Soft shadow - radius (m) 0.02
Shadow (BSD only): Turns shadowcasting On/Off. Only works for the Adaptive | container
BSD. -
Evaluation
Diffuse
Soft Shadow - radius (m): Makes the light cast soft shadows by changing the | g 1nsucent
radius (in meters). Reflectance

Transmittance
To select the Container and Evaluation options, first click the hamburger menu Medium and 555

icon. Create lights

Container: If the light is placed inside a container made of a material with the ‘ ‘@ ‘ ‘ ‘ ‘ ‘ /ﬂ ‘ ‘ QJ\ ‘
properties of a medium, or if it is submerged in water, ‘Container’ lets you

select a material for the container. It can be also used to show a volumetric

projection of light.

Evaluation: Tells the light whether it should affect the listed material properties. Example: If the Diffuse is unchecked, then the light will
not affect the diffuse color of the object.
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EDITING LIGHTS
Double-click a light component (or single-click when the Thea Tool is open) to access the light's properties. On top of the Light tab, the
name of the current light is displayed.

Point Light and Spotlight Properties

] Point lights and spotlights share several properties:
Emittance: The color of the light is controlled by the color of the light's material. But if

Mame: ’thea _spotlight

Emittance X . :

T 200 [Watts il Temperature is enabled, it controls the color of the light.

Efficacy (Im/W) 20

Atennation [1nverse Square - All lights have the following parameters:

[7] Temperature (K) 2854 | Power (multiple units available), Efficacy (Im/W), Attenuation, and Temperature (K).
:T;::: — » Unique Spotlight Properties

Fall Off 15 Spotlights have two additional values that control their cone shape.

Hot Spot: The angle at the tip of the cone, where light is emitted at full intensity.
Fall Off: The angle at which the light fades away.

IES Light Properties

-] Multiplier: Use this option to modify the intensity of the IES light.

Mame: ’thea_ie:light

Emitta o . .

D"'Tem":murem o In general, it is recommended to keep the default value of 1.0 because IES lights simulate
physically accurate lights. To make the rendering brighter, adjust the display settings instead.

IES light options

Multiplier 1.0

bt arghins The default IES light uses the sample .ies file. A preview image is displayed below.

sample.ies You can select another IES file using the drop-down menu and clicking the ‘Load’ button.

To use your own IES file, select ‘Other file’ from the drop-down menu and click ‘Load’. Select the
desired IES file, which will be saved with the light component.

Tip: The IES description is saved inside each IES light component. You can safely share SketchUp
models with others without including .ies files.

Projector Light Properties

2 A projector light emits light in the shape of a square pyramid to display images on surfaces. If
an image is not selected, the projector light will emit a color (defined by the color of the light's

Mame: ’thea_projector

Emittance

material or the Temperature parameter).

i::::t' = Use 'W x H' (Width and Height) to change the size of the projected image. By default, the aspect
ratio is locked. Click on the chain icon to unlock it.

Power 12796 [Watts - ] . . .

Efficacy (Im/W) 5 Power, Efficacy, and Attenuation are the same as they are for other light types.

Attenuation [Inverse Square ']

[F] Temperature (K) sasa | Tip: It is important that the distance between the light source and any adjacent geometry is

greater than the radius of the light; otherwise, the final rendering may contain undesired “noise.”
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6.4. ENVIRONMENT TAB

G €| | o @ Toggle Sky: The background is a clear sky that changes automatically according to the position
_ of the sun. If a background image is not used, it is disabled.
= o | ‘@: Toggle Sun: Creates a sun that produces the same shadows as in a SketchUp model.
L - Toggle Ground Plane: Toggles on/off a ground plane that catches shadows and reflects objects.

f
E
g
O

Toggle Preview Widget: Hides/Unhides the Preview Widget. The widget gives a preview of the

Default environment and updates automatically. When Manual Sun is disabled and IBL lighting is being
! Sun/GROUND/SKY TaB
P — Manual Sun
Roughness 10 By default, the intensity, position, and spectral color of the sun are
Reflections 0% | handled automatically, based on the shadow settings in SketchUp. The
Reflections Color [ ] Manual Sun option lets you override these settings.
Sky Settings =
Turbidity 250 When Manual Sun in enabled, you can modify the softness of Sun
Ozone 035 | shadows with the multiplier, power, and emittance settings.
Water Vapor 2.00
ibdityCostiaent %051 |f you want complete control over the Sun's position regardless of | = =
A R 13 SketchUp's Shadow settings, disable "Use SketchUp Sun position." You | Vel =
can adjust the sun Polar Angle and Azimuth, either by entering the
desired values or by opening the Environment Preview Widget and
clicking the preferred location in the preview.
Ground Settings
The Ground settings let you control the way the ground plane reflects light. You can specify
roughness of the reflections as well as their intensity (%) and color.
Sky Settings
The Sky settings affect the appearance of the Thea Physical Sky. The most important parameter is
Turbidity which requires a value of approximately 2.5 for a clear sky and close to 10.0 for an
overcast one.
G| €& @ Ty IBL TAB
o @ | Use the IBL Tab to specify the lllumination, Background, Reflection, and Refraction maps.
o Tre Image-Based Lighting is a convenient way to add illumination to your scene. A photo of a real scene
e can be used, to create highly convincing lighting and enhance the realism of your renderings. In
T ' most cases, you need to use High Dynamic Range images to provide sufficient
Intensity 1.0 ||ght|ng
Rotation 0
R You can use one image for illuminating the scene or set up different images for the background,
| ElBackground reflections, and refractions. This makes it possible to use different sources for lighting and for the
Path: background/reflections, which in most cases need more detailed images. This is actually standard
Intensity 10| practice: the illumination source is a relatively low-detailed texture so that the image can quickly
Rotation 0 “converge,” while the background and reflections use a detailed map for visually enhanced results.
[CReflection To add an image, select the type, and click the [ad putton to select the desired image. When a
Path: bitmap is selected, its path is displayed next to the button. You can control the Intensity, Rotation,
:t:":'t" 1'2 and Wrapping (the way the image is wrapped around the model).
otatien
There is also an option to use a pure color for an IBL slot. You can access this option by clicking on
| the image icon and selecting 'Color.' From this menu, you e
Path: _ can also remove the image currently loaded in the slot by | “iumination ‘ \
Intensity 1.0 . " . " Path:  Autumn Hockey\autumn_hockey_dk.hdr Color
Rotation 0 selectlng Remove Bltmap' Intensity 14 .y Remove Bitmap
Wping o L
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b T GLosAL MEebpium TAB
| Giobal Modum | Medium Type (Fog)
Medium Type Foq ~|| With the Fog preset, you can achieve model-wide volumetric effects. Using the Cloud preset,
Fog Density 0% | volumetric effects can be created within a specified volume.
Top Level (m) 20| Fog Density: Control the thickness of the fog.
Base Level (m) 00 Top/Bottom Level (m): Define where the fog starts and ends.

Mebium Type (Custom MEDIUM)
M When you switch to Custom Medium, the entire modeling space is filled with a global medium,
| | which can be tweaked using the Absorption Color, Scatter Color, and Index of Refraction
| parameters. Please note that Sky, IBL, and Sun don't work in this mode due to the global nature

(- s = ' of the medium.
Global Medium )]

| Medium Type Custorn Medium V]

Absorption Color |
——J]

Scatter Color E

Index Of Refraction 1.0
Absorption Density 0.00
Scatter Density 030

Copyright © 2018 - Altair Engineering, Inc



-+
;"JRENDER

S Altair

7. SETTINGS PANEL

7.1. DispLAY TAB

The Display tab is a very important area where you can manipulate your rendered image

iR - (especially in terms of exposure/brightness, color saturation, and contrast) and apply other post-
Sy ek processing effects.
Exposure
Tonemapping Exposure
Iitter 1;2 Tonemapping: Select a tonemapping method: Standard, Filmic, Reinhard Global, Reinhard Local.
T e ISO: Defines how sensitive the image sensor is to the amount of light present. A value of 100 is
i - mostly used for exterior shots under a clear sky and sun lighting. Higher values, usually between
Badhies . 400-1600 are used mostly for interior shots.
Shutter: The shutter speed corresponds to the duration a camera shutter stays open, measured in
Camera Response Function 1 1/sec. Low values result in brighter images.
Advantic-100CD.crf ~| | f-number: The lens aperture is the ratio of the focal length to the effective aperture diameter.
Low values make the image brighter.
Eheim Gamma: The gamma factor typically ranges from 1.0 to 2.5. In order to compensate for the
Slepiey ¥% darkening of the image due to non-linear output, we apply a gamma correction scheme to the
2L 0% pixel values before displaying the image.
Zi:"em"g z: Brightness: This parameter is used to compensate for a linear scaling of the image by a monitor.
roma
;\Lh:e atance (0 EZ;; Camera Response Function
Pl Glore Camera Response Function files use real data provided by the camera manufacturers to create
Weight == realistic (non-linear) display results, as if the image were taken with that specific camera.
Radius 4%
Filtering
EpndizirEs Il sharpness: This is the most important option for controlling filtering during downsampling of the
Blend with original 0% image. It is advised to use the default of 50%, which is a balanced value between blurring and

Other

Stereoscopic

Anaglyph -

sharpening. A value near 0% produces a more blurred image, while a value near 100% produces a
more sharpened image.
Burn: The burn value can be used to compress a High Dynamic Range (HDR) into a Low Dynamic

Range (LDR) image, presentable on screens and other limited range devices. Setting burn to 100% means that there is no compression.

Vignetting: In photography and optics, vignetting is a reduction of an image's brightness or saturation at the periphery compared to the
image center.

Chroma: Increase the value to enhance the colors of the image. Chroma acts as a saturation control.

Contrast: Determines the difference in the color and brightness of the object and the objects within the same field of view. 0% equals a
disabled control. 100% is the maximum value that can be set.

White Balance (K): Change the overall color balance of a render, so that it matches the expected physical phenomenon. A value of 6500K
is usually used to balance sunlight and make white walls appear white, even if the sunlight is yellowish.

Glare: Glare is the effect of a high amount of protons arriving at a film, causing lighting to also flood nearby areas. The shape of the glare
itself depends on the shape of the diaphragm.

Glare Type: Select how many blades you want. Radial equals Bloom.

Glare Weight: Controls the intensity of the glare.

Glare Radius: Controls the length of the blades.

Optix Denoiser

Optix offers Al-accelerated denoising. The denoiser can be enabled before or after the rendering has finished. If you enable Optix before
starting the engine, two additional channels are enabled to ensure the best denoising quality. These channels are Normals and Raw Diffuse
Color. An NVIDIA GPU is required for Optix to work.

Blend with original: Controls the blending between the original and the denoised image.

Other
Stereoscopic: Use this option to produce stereoscopic images (Anaglyph, Left, Right, Left/Right, Top/Bottom).

Info: The Stereoscopic options need to be enabled from the Camera tab before using the options in this dialog.
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7.2. RENDERING TAB

© | & [B]*

Presto (MC) Settings =

Tracing Depth 5

["] Diffuse Depth 0

Clamp Level 1.00

Ambient Occlusion =
Extended Tracing =]
Transparency Depth 15

555 Depth 15

Internal Reflection Depth 15

Devices

GeForce GTX 1080
GeForce GTX TITAN X

Intel(R) Core(TM) i7-5820K CPU .| Low  +|

[7] Pitcairn - Advanced Micro Devic.. Low ~
Clay ]
Reflectance 30 % |
Network Rendering -l
Server Mode lRender and Manage 'l
Server Port 6200
Distribution

Threads Max b4
Pricrity Low .4

Distribution

The Rendering Tab displays the selected engine parameters along with every other common
render setting like the Devices List, Network Rendering, etc.

Engine Settings
In this section, only the selected engine's settings will be displayed. You can find detailed
information about each engine in Section 8.1.

Devices (Presto MC only)

Provides a list with all devices that have been detected on your system. That includes the CPU and
any NVIDIA/AMD graphics card. It is possible to enable/disable devices individually and set the
priority of each. It is best to disable the GPU that is being used by Windows for machines with
more than one GPU.

Clay

By enabling this option, all materials in the scene will be rendered as diffuse gray, giving the final
image a clay effect. Material properties like bump and clipping can still be seen in the final render.
Reflectance: Increases/Decreases the diffuse material reflectance (from black to white).

Network Rendering

Network rendering is only available when in Production Mode. To start using machines on the
local network, enable Network Rendering by clicking on the checkbox.

Server Mode: There are two options to choose from. "Render and Manage" makes the server
machine render along with the rest of the nodes. "Manage Nodes Only" should be used when
the server is not powerful; this way, the server doesn't execute the rendering itself but just
exchanges data with nodes.

Server Port: The default value is 6200 and is used for communication between the SketchUp
(server) and nodes.

For more information on Network Rendering, go to section 9 (Network Tab).

Threads: Refers to the worker threads used during rendering. While the default value is set to Max, you can use the drop-down to select

the preferred amount of threads.

Priority: This parameter corresponds to the priority assigned to render threads by the operating system. Select 'Normal' to make rendering
faster; however, 'Normal' is not recommended when you use the machine in parallel or run other demanding processes.
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7.3. CHANNELS TAB

s s 3
L, ﬂ ps ~

Presto (MC) Channels

This tab is used when an additional image, other than a standard rendering, is required. This is
mostly used when you intend to do post-processing using an external image editing program.

Active Channel [Color v] Available channels are: Color (standard rendering), Normal, Depth, Alpha, Object ID, Material ID,
[F] Denoise and channels specific to Adaptive (BSD) rendering mode (Direct, Ambient Occlusion, Global
[ Normals Illumination, Subsurface Scattering, Reflection, Refraction, Transparency, and Irradiance). Some
EEFP;: channels like Shadow Channel, Raw Diffuse Color, Raw Diffuse Lighting, Raw Diffuse Gl, Self
B Of.;ectm Luminance, and Pass per Light are only available for Presto engines.
[ Material ID

Di . . . . . . .
[ Direct When 'Pass per Light' is enabled, independent images will be produced for all available light
a0
EGI sources. This can consume a lot of memory when there are many lights and the resolution is

555 .
[ Reflection high.
[ Refraction
Efﬁf't'c‘” Mask passes will only appear when you assign a mask to a group, component, or image using
[| Shadow the Thea context menu.
[ Mask
[ Raw Diffuse Color . . . . .
[F] Raw Diffuse Lighting Active Channel: Displays the selected channel in the Rendering Panel. After a rendering has
Ezﬂmﬁiﬁqse Gl been completed, every enabled channel is displayed in this list.

elf lllumination
[ Pass per Light

= Denoising

Denoising - e s . . .
Strenth p— This is the built-in denoiser of Thea Render. You must enable the Denoise Channel in order to
= lg | see the denoised image and use the strength and Details parameters.

als

Strength: Controls how much the denoising filter will affect the final image.

Depth Channel Range Details: Controls how much of the original detail of the image will be kept in the final rendering.
Min Z (m) 00| Higher values will try to keep as much detail as possible.
Max Z (m) 100 | Depth Channel Range
Photometric Analysi - Min/Max Z (m): Controls the minimum and maximum distance along the camera's z-axis.

OMELNC ANalysis
i o Photometric Analysis
M I Lo 15000 Luminance analysis describes the luminance and illuminance distribution. Thea Render can

compute both. Luminance is computed out of the box for any image that you have already

rendered and for any render settings. Illuminance can be computed by the Adaptive BSD engine. To view the analysis of a rendered image,
select ‘Photometric’ from the drop-down menu. Min/Max Il-Lum: These values represent the range of the Luminance (cd/m2). By
changing these values, the false color image is updated accordingly.

7.4. ANIMATION TAB
_ Thea is capable of rendering the following types of animation:

[ Animate camera - Standard camera animation based on SketchUp scenes; however, Field of view changes won't

[¥] Animate objects be applied.
- Object and camera animations based on various SketchUp plug-ins that display animation

Plug-in: lGeneric v]
b 52 When you play SketchUp scene animation. This mode is called ‘Generic.'
i Ea [A” -] - SketchyI'DhyS|c's anl'matlons that can be replayed with SketchyReplay
- MSPhysics animations (0.80+)
- Fredo's Animator animations
Render Animation ]
Animation is exported as a series of numbered images. You will have to convert them into a
Network

playable video file using specialized software. VirtualDub is a free, open source example.

Cooperation [Frame ']

The animation tab controls the following parameters:

Walkthrough (BSD) Animate camera: specifies whether camera movement will be animated.

Lighting precision [100% v] Animate objects: specifies whether object movement will be animated. It requires an animation
plug-in, because SketchUp itself doesn't animate objects.
Frames per second (fps): controls fluidity. How many animation frames will be played per
second. Standard values are 24 or 25 fps.
Plug-in: Generic, SketchyPhysics, MSPhysics, Fredo's Animator. The selection defines what plug-
in will be responsible for object movement.
Render Frames: All, Selected. Specifies whether Thea should render all specified frames in a

field below. You can enter single frame values or frame ranges, separated by commas (e.g., 15,30-45,60).
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Network cooperation: Frame, Bucket|Pixels. This is only used when rendering is performed through a network using nodes. It controls
whether computers in the network will render whole frames independently (Frame) or contribute to each frame (Bucket|Pixels). We
recommend using Bucket|Pixels, because this minimizes the network bandwidth needed to send whole frames from the nodes to the
server. It is also more efficient when computers of varying performance are in the network.

When using the Adaptive (BSD) engine and pure camera motion, you can also enable the Walk-through option. It will speed up
walkthrough rendering because lighting calculations will be done just once and shared among all frames.

When you click the "Render Animation" button, you will be asked to select a folder and specify a file name. Frame numbers will be
appended automatically to the file name (Animation000.png, Animation001.png, etc.).

Please note that for the time being, Thea For SketchUp doesn't animate standard lights. Fredo's Animator can animate standard lights, if
you start rendering the animation from the Animator instead of Thea.

8. RENDER ENGINES

8.1. RENDERING MODES

Thea for SketchUp offers two rendering modes: Interactive Mode and Production Mode.

T Thea Render for SketchUp
Control Panel

Interactive Mode (IR) (> Nl 64
IR modes allow you to not only render the model as a static image, but also interactively move
the camera around the model, adjust shadows and materials, modify the model, and see the
rendering being updated. Engines that offer Interactive Mode are: Presto & Adaptive AMC.

Render Window | Batch Rendering .~ Console” Network

Production Mode (PR)
PR mode is used for final renderings where changes to the scene do not affect the final image while rendering. All engines can be used in
Production Mode (Presto, Adaptive AMC, Adaptive BSD, Unbiased TR1/TR2).

Tip: It is possible to render only the selected object by enabling the checkbox next to the Start button.

8.2. PRESTO

S & B - Thea Presto is an advanced rendering engine that has been written from the ground up and is
e -~ — optimized for simultaneous GPU and CPU execution, thus harnessing all your computing power.
SN St The engine has been optimized for fast, interactive rendering. This pushes GPU+CPU computing

Tracing Depth 5| to the limits while keeping the high, photorealistic quality of Thea Render.
[ Diffuse Depth i}

B Glamp Level 1001 presto Settings

[¥] Bucket Render

Tracing Depth: This is an important parameter for progressive engines. Increasing this parameter
Ambient Occusion ] may be necessary for certain cases where there are a lot of mirrors or dielectrics in the scene, but
it has a direct impact on render times.

Diffuse Depth: This is a separate value that controls tracing depth for diffused surfaces. Setting

Extended Tracing Diffuse Depth to O removes all light bounces from the scene, leaving only the direct light.
Transparency Depth 15

555 Depth 15| Clamp Level: Clamps the evaluation of a pixel, improving antialiasing. The number corresponds
Internal Reflection Depth 15| to the clamping limit. When you use a value higher than 1, clamping becomes less effective for

antialiasing. When you use a value less than 1, clamping becomes more effective, but it also
more aggressively lowers the brightness of the image.

Devices

GeForce GTX 1080 Low w7

Bucket Render: Rendering high resolution images with multiple channels is usually an issue for
GPUs, but with the use of bucket rendering, you can overcome this limiting factor and improve
scalability as well.

Ambient Occlusion
Ambient occlusion can be used to mimic a part of global illumination, making the rendering engine faster.

Distance: This is the maximum distance that the sample may be evaluated to an intermediate (gray) color. After that distance, the sample
is evaluated to a white color.

Intensity: This value defines the intensity of the ambient occlusion used.
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Extended Tracing
Extended tracing can efficiently render scenes with transparent objects or materials with subsurface scattering while using a lower tracing
depth.

Transparency Depth: Determines the extended tracing depth for all transparent materials like Thin Glass, Glass, and Clip Map.

Internal Reflection Depth: Determines the extended tracing depth for transparent materials that have refraction and total internal
reflection. These materials are created with the use of the Glass Layer (e.g., solid glass or water). If you notice that you get dark areas on
solid glass, this is often the result of the Internal Reflection Depth being too low, not because of the Transperency Depth.

SSS Depth: Determines the extended tracing depth for subsurface scattering (SSS) materials. In some cases increasing this value is needed
to increase the brightness of brightly colored, and dense SSS materials. Not available when Diffuse Depth is enabled.

Advanced Settings

Supersampling: This corresponds to the supersampling used for the image output (i.e., internal resolution multiplier for antialiasing
enhancement).

'None' corresponds to no supersampling at all, 'Normal' to 2x2, and 'High' to 3x3. 'Auto' corresponds to no supersampling for the biased
engine (disabled by default).

Setting supersampling to a higher level generally improves antialiasing of the output, but increases memory demands for storing the image
(by 4 times for 'Normal' and by 9 times for 'High'). The time needed to render the scene is also increased for a biased engine.

8.3. UnsiAseD TR1/TR2

Thea Render supports a superior, unbiased core, which is one of the most advanced on the market and delivers stunning images without
any compromises. All possible paths of lighting transfer are explored, delivering the highest accuracy without any artifacts. Sun-pool
caustics and terminator artifacts are robustly handled, offering stunning results.

Unbiased TR1/TR2 Settings

These two engines have no settings and are controlled only by the Sample and Time Limit.

Unbiased engine TR1 is optimal for exteriors and scenes with dominant direct lighting, while unbiased engine TR2 is optimal for extremely
difficult indirect and caustic lighting.

8.4. ApaprTive BSD

Thea biased engine (Adaptive BSD) uses interpolation schemes such as an irradiance cache to

9 & [E - render in shorter times and is implemented so more effort can be put where it is needed most.
dcdagties ST sl Furthermore this effort is driven by perceptual criteria, generating high-quality results that are
hecs 00. Exterior Preview perceived naturally.

Clay
P ~ Adaptive BSD Settings
The Adaptive BSD engine uses a preset workflow to let the user control the engine. There are

AT IR T several presets for interiors and exteriors, as well as different qualities for each (draft, low, high,
Server Mode Render and Manage etc).

Server Port
Distribution
Threads Max
Pricrity Low
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8.5. ApapTive AMC

@ | & [E | =
Adaptive (AMC) Settings

Tracing Depth 5
Adaptive Bias 25 %
[ Caustics

Clay o
Reflectance 50 %
Network Rendering
Server Mode [Render and Manage ']

Server Port T894
Distribution

Threads | Max - |
Priority | Low hd |

The Adaptive AMC engine is based on the Unbiased TR2 engine but with shortcuts to make it
faster. It should be preferred for difficult, indirect lighting situations (e.g., indirect caustics) and it
can be used in both Interactive and Production Mode.

Adaptive AMC Settings

Tracing Depth: Just like in the Presto Engine, this is an important parameter for Progressive
Engines. Increasing this parameter may be needed for certain cases where there are a lot of
mirrors or dielectrics in the scene, but there is no direct impact on render times.

Adaptive Bias: By increasing this value, several difficult paths are taken out of computations,
making it faster.

Caustics: Removes the caustics path. In general, it should always be enabled.

Tip: When rendering interactively, screen resolution is used instead of camera resolution. Disable the ‘Interactive’ option to render at full

size.

9. NETWORK TAB

Network Rendering is only

T2 Thea Render for SketchUp [folrE ==
ava”able for producﬁon mode' Rendaerdow/Batch Rendering -~ Console”” Network v | e -
. r T i P : = ' e o | & [BE =

To enab|e network renderlng, Address Status | Contribution Commits | Last Commit | Subscription | Threads Platform Revision preoreEo— -

. ; .

go to the Settings Panel and || —— T 5

switch to the Rendering Tab. |2 "D“C““:Bi“ B
Turn on Network Rendering by

. e Clay O

clicking on the checkbox. Reflectance 0%

Metwork Rendering

When setting up network AR (Render ana Manage -]

) Server Port 7894
rendering, make sure all
computers are properly

connected to the network and
able to share files, access

network drives, etc. It is important that port 7200 is open in the Windows firewall or any other firewall installed on a machine in the
network. By default, this port is used for communication between the SketchUp server and nodes.

You may find more information on how to set up render nodes in Appendix B.

When rendering starts, the Network tab displays the nodes that have been found, and after a while (depending on the model's complexity)
they will have been commited to rendering on the server. The Network Tab displays all machines that are connected to the SketchUp
server, along with their status, contribution, and technical details.

If the server isn't powerful enough, select "Manage Nodes Only" before clicking the Start button. This way the server doesn't execute the
rendering itself, but just exchanges data with nodes. Please note that the "Manage Nodes Only" option does not work with Adaptive (BSD)

engine.
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10. ConsoLE TAB

T Thea Render for SketchUp
RenderWindow/Batch Rendering/VConsole ]/Network ]
Thea for SketchUp 2.0.00.727.1798 - =4

Loaded from: C:/ProgramData/SketchUp/SketchUp 2018/SketchUp/Plugins/TheadSU_files/ —— — : : 1
Display Settings

Autosave enabled.

Session folder: E:/Thea Data/Temp/5ession_00000189 Exposure
. Tonemapping
150 100
Shutter 250
f-number 56
Gamma 2.2
Brightness 100 %

The console displays the plug-in version, installation path, rendering progress, rendering time, and warnings. Open the console if
something doesn’t work as expected, as it can help you find the source of the problem. The console opens automatically if a significant

error occurs.

11. BATcH RENDERING TAB

- Thea Render for Sketchlp = lo == | The Batch Render window lists all of the available
enderWindow," Batch Rendering | Console) Network | < | [setings Pane * .
e tinon B fevderma [ ol et =T T scenes in a table. Select the scenes to render and
“ e ‘Q ‘ ST | | settings to apply (Camera, Display, Environment,
r ene Name: mera is Environmes ri rogress Exposure . .
e | o | e ] T | — Rendering). Then click the Start Batch Render
@] Scene 2 @] @] @] =] 150 100
G Scene3 a a a a Shutter = |button.
f-number 56
Gamma 22 . . .
Brghtness w=||A new window opens, allowing you to specify the
e location of the rendered images. During rendering,

information on the batch process appears at the
bottom of the window.

You can click the Stop button at any time to stop rendering.

Tip #1: The ‘Refresh scenes’ button clears previous selections so you can start over.
Tip #2: You can save the settings of a scene using the Camera tab in the Thea Tools window as described on page 5.
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12. WINDOW SELECTION FOR INTERACTIVE RENDERING - OVERLAY OPTION

’prmo MO ,lﬁnsmchupmth — | Rendering is enabled, use
— — in Thea Window — the drop-down list to
Batch Rendering . Cain SketchUp Window choose between displaying

Blended with SketchUp the interactive rendering in
Multiplied with SketchUp the Thea window (see
right) or in SketchUp as an
overlay (see below).

‘With edges’ mode is especially well-suited to interaction with SketchUp
models. This mode temporarily modifies the SketchUp display style to
clearly show edges in exterior/interior models. You can navigate, modify
materials, add models, and see the changes take effect in SketchUp while
rendering.

When Interactive T2 Thea Render for SketchUp [Ee =S e

| Control Panel

@ O | [W][prestomcr ~][in Thea Window A g a5l = O o

‘Blended’ and ‘Multiplied’ give you full freedom to set up SketchUp style.
‘Blended’ works best with dark backgrounds and bright lines (like ‘With

edges’). ‘Multiplied’ is the opposite and works best in hidden line mode with a white background.

The rendering can be saved as an image, both in standard and overlay modes.

CH AFBGCIXOIR R PRAROR B EBEBE Ul [ mr ==

em\®- ¥
om\j2- 7Y
oz a0 i

©x2

"6 T
Sn e T

T XV N RO
SN e

T=X%e s KO+
5 >

PR

Blended With SketchUp

Multiplied With SketchUp

Tip: While using the overlay and modifying a model, the best results can be achieved with Presto engines using only GPU for rendering. CPU

shouldn't be used, but should be made available to SketchUp.
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INTERACTIVE REGION RENDERING IN SKETCHUP WINDOW

Interactive rendering in the SketchUp window allows you to render a selected
area of your scene. When interactive rendering is on, hold down the Shift key
while clicking and dragging to select the desired area. Multiple regions can be
displayed at the same time. You can also save an active region by clicking on the

Save button.

RENDER A REGION IN THE RENDERING WINDOW
After rendering, you may decide to edit a specific region. Instead of
re-rendering the entire scene, you can re-render just the region.
Right-click and drag to select the region to re-render. The selected
region will be outlined with green dashed lines, and its size will be
displayed.

Please note that although the whole image will be displayed, the
display settings will only affect the selected region. In general, it is
not recommended to modify the settings, as the result will not
match the original image.

The entire image can only be saved in non-HDRI formats. The
region can be saved as an Exr, img.thea, or HDRI.

13. THEA BROWSER WINDOW

T Thea Render for SketchUp

‘Control Panel
[» Nl | Presto (MC)

Start or Resume(+ Ctrl) rendering
0

[2=8 Fol |

=

o €& '@

| 256 0

T Thea Browser

Thea folders

Materials

Brick Walls
Carbon Fiber
Cloth and Leather
Exterior Pavements

Floor

Metals

NS Slabs

NS Tiles
OnlineMaterials

1:d_leather 16.mat thea 20_leather_03 matthea 2:2_leather_04.mat thea

Parquet
Plastic Surface Finish
Rough

Semi Transparent Plastic
Thea_Concrete 01
Transparent

Wall Finish

e 2
2:2_|eather 05.mat thea dxd_Leather 0L.mat.thea 41d_Leather 07 mat.thea

Model Info

4xd_leather_10.matthea 4x4_leather 11.matthea

44 _leather 09.mat.thea

-
4x4_leather 08.mat thea

oo s

With the Thea Browser, you can:

e quickly access Thea materials, external models and skies,
and SketchUp components in the 'Thea Data' folder

e access the same items in user-defined 'Custom folders'

e find currently used and missing external textures, models,
and other image maps

¢ zip a SketchUp file with all external dependences (textures,
images, and models)

Please note that Thea provides a wide range of material
libraries, as well as models and skies/studio lighting set-ups.
You can find more information on how to download and
install Thea Libraries in Appendix C.

-| Double-click the desired material or model. You can then

L
E/Thea Data/Materials/Leather

apply the material to a surface or insert the model at a

Online Repository
Custom folders,

(- Model Info Add folder
Refresh

You can create a custom folder by right-clicking and selecting the 'Add

Birch_Tree 03_6m.mod.thea

Birch_Tree 04 8m.mod.thea

Create proxy component: Birch_Tree_03_6m.mod.skp

desired location in SketchUp.
Double-click Thea Sky to enable it and add it directly to the
IBL of the Environment tab. Please not that skies may alter the

current display settings.

folder' option. You can also right-click to refresh or remove folders.

External Thea models usually contain very complex geometry. It is not feasible to load them directly in SketchUp. By default, Thea only
imports the bounding box of an external model, but in general it is better to have a 'proxy' component that will resemble the shape of the
full geometry. Right-click to have Thea create this approximation automatically. See page 35 for more details on proxies.
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A SketchUp model (*.mod.skp) can be written in the same folder as the Thea Model (*.mod.thea). In this way, the SketchUp file will be
used instead of the bounding box when inserting the external models as a proxy. When mod.skp is present, its preview will be displayed on
top of the mod. thea preview, as shown in the image.

Applying a material from the Content Browser
You can apply a material from the Thea Browser window to the Thea Material Editor by right-clicking a thumbnail and selecting "Apply to
Edited Thea Material."

Note: You need to open a material in the Material Editor before you can select or replace it.

13.1. MobEL INFO

Thea Browser also has a Model Info section which shows External Dependencies associated with a model.
This window allows you to view and find/modify/update external textures, IBLs, and models used in the scene.

% Thea Browser EI@
=+ Thea folders File name Referenced in Size
bl E:/_PROJECTS/Scenes/SketchUp/Classic Interior/Herringbone_Bump.jpg Wood Herrinbone 680.0 KB
E:/_PROJECTS/Scenes/SketchUp/Classic Interior/Herringbone_Color.jpg Wood Herrinbone 878.0 KB
E\Thea Data\Models\Door Handle.mod thea Door Handle.mod.thea 1.5 MB
T o E\Thea Data\Models\Consele Table I.mod.thea Console Table I.mod.thea 2.3 MB
EI Model Info E\Thea Data\Models\Switch.mod.thea Switch.mod thea 198.8 KB
El E\Thea Data\Models\Chesterfield.mod.thea Chesterfield. mod.thea 149 MB
... Textures E\Thea Data\Models\Gelden Desk Lamp.mod.thea Golden Desk Lamp.mod... 4.9 MB
- IBLs E\Thea Data'Models\FlexForm_Bed.mod.thea FlexForm_Bed.mod.thea 71 MB
Models E\Thea Data\Models\Vase.mod.thea Vase.mod.thea 3.0 MB
L ]
O e Eii;5QIQ{EZEEEQ{EZi;-!hi!%?f}h'i Saving the SketchUp Model with Dependencies
g ﬁvemwvmmw::m:Znen:e:jesu EHM P Right-click on Model Info to save the entire scene with dependencies (textures, external models, etc.)

i Textures
IBLs
i Models

3 =
E:\Thea Data\Models\FlexForm_Bed.r | n. * Zi p fo rmat.

E:\Thea Data\Models\Vase.mod.thea

14. PREFERENCES

Plug-in Preferences EI@ General Tab

General |Interactive Render I Channelsl Language

=== o Click on the Preferences button to open a window where you can change the
Language. Then follow these steps:

e o e e ok e e - Locate the TheaForSketchUp.po file in the folder: TheadSU_file/languages/

[¥]Use back face material when front is absent - If needed, translate the file using Poedit and compile to a .mo file.

[¥] Weld vertices - Copy the translated TheaForSketchUp.mo file to the corresponding language folder.

[l Autosave every (minutes) 1011 Typical country codes are: de (German), es (Spanish), fr (French), it (ltalian), ja
(Japanese), pt (Portuguese), pt_BR (Brazilian Portuguese), ru (Russian), zh_CN
(Chinese Simplified), and zh_TW (Chinese Traditional).
- If the desired language has already been configured, it will be used automatically

when SketchUp starts. Otherwise, open Thea Tool/Tools/Preferences and select the
language manually. For example, if you placed the TheaForSketchUp.mo file in the es (Spanish) folder, you will be able to select Spanish
from the Language drop-down list.

-The language changes will take effect after you restart SketchUp.

Use Back Face Material: This option applies to models where multiple faces are painted on the back side only (the front face has no
material). When this option is enabled, SketchUp will use the back face material for rendering instead of the default white material.

Weld Vertices: This option is disabled by default. Enable it to weld the vertices of objects when converting SketchUp models to Thea
format. This is actually only required for objects with displacement or a wireframe procedural texture. The welding is performed
automatically for geometry using displacement. It is recommended to enable this option only when using the wireframe texture.
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Auto Save: When Auto Save is enabled, Thea automatically saves the rendered image every 10 minutes (this is the default time, but you
can change it). To find the Auto Save location, go to the Console of the Rendering Window.

Plug-in Preferences

General | Interactive Render |Channals|

[F=1 Hem

Initial Appearance:
Higher Quality
Resolution Reduction for IR Overlay:

Mo Reduction U

U Mare Responsive

8x

Plug-in Preferences

‘ General |Interactive Render | Channels |

=5 EoE

Use multi-layered EXR cutput
[]Force RGE in EXR output

Color
MNormal
Depth
Alpha
Object ID

Material 1D

-

Exp =L

16 bit -

Exr =

Exr =

15. Section CuTs

Interactive Render Tab
Initial Appearance: Use the slider to find the best balance between rendering quality and
responsiveness. The more responsive, the less precise the initial frame.

Resolution Reduction for IR Overlay: You can render at the same resolution as your monitor,
but this is not practical when you have a high resolution monitor. The resolution reduction
option lets you reduce the rendering resolution so you can render faster (the image still maps
correctly to SketchUp view). It is highly recommended to use resolution reduction if you have
a 4K+ monitor.

Channels Tab

Use the Channels preference panel to select a format. For EXR, you can select a bit depth for
each channel. Note: Not all channels require 32-bit depth; only some (e.g., position, depth,
and UV pass) will benefit from 32-bit depth.

To save the render passes as one multi-layered EXR file, enable the option “Create multi-
layered EXR including all channels”; otherwise, each channel will be saved as a separate file.

SketchUp section cuts are fully supported when placed directly in a model. If they are nested inside a group, the whole model will still be
cut, not just the geometry in the group.

Note: Unlike in SketchUp, when you cut a room/object, sunlight will not penetrate. Thea preserves the original lighting conditions, which is
especially useful when you want to take shots of narrow interiors with exactly the same lighting as designed. Without a section cut, the
camera would be obscured by an existing wall.
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16. THEA CONTEXT MENU

Click on a component, group, or image to access the Thea context menu. This allows you to perform a function on an object or modify
object-specific properties.

Create External Model/Proxy
This option lets you export a component into an external Thea model and create a reduced placeholder for it. This may help you keep the
SketchUp file size small, while having high polygon models visible only in your renderings. The process in described on page 35.

Assign Mask Index
This item allows you to assign a mask index from 0-15 to a selected object. If you enable "Mask" channel in the Channels tab in the
Rendering window and start rendering, you will see that a white mask on a black background was created for this object.

Thea Model Flags

Thea for SketchUp gives you a way to control the visibility and
; \ shadows of individual components, groups, and images in a
W )’ \ rendered image.

_ > ~ Rightlick to access the Thea Render context menu/Thea Model
|l ] Flags/'Visible' or 'Cast shadow.'

The property is applied to sub-groups or sub-components.

Soften/Smooth Edges
Zoom Selection

Dynamic Components >

ViSible: ON VISIbIe OFF Thea Render 2 Create external model/proxy
Assign Mask Index
Cast shadow: OFF Cast shadow: ON Thea Model Flags > ¥ visible

17. TROUBLESHOOTING

- There is no Thea plugin visible in SketchUp on my Mac.
Please start SketchUp at least once before running the Thea installer; otherwise the SketchUp version will not be recognized.

- My NVIDIA GPU graphics card is not recognized.
Please make sure your GPU is part of the following list: https://developer.nvidia.com/cuda-gpus and that you have the most recent
graphics card drivers installed, including CUDA.

- My rendering is very dark.

The default display properties are set for exterior daylight conditions. If you are rendering interior views, you need to adjust the ISO,
Shutter speed, and f-number values, as you would a manual camera. An I1SO of 800, shutter speed of 60, and f-number of 2.4 should be a
good starting point.

For a complete guide to accurate light intensity and camera exposure, please see:
https://thearender.com/site/index.php/resources/tutorials/studio-general.html
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18. CReATING EXTERNAL MODELS & THEIR PROXIES

To keep SketchUp model sizes small and still produce very high-quality
renderings, export the heaviest components (trees, cars, etc.) into
external .mod.thea files and replace them with simplified ‘proxy’ versions in
SketchUp.

Proxies can also be created for Thea models that come from other
modeling applications. This can be done in the Thea Browser.

Every SketchUp component can be exported into an external .mod.thea file
and replaced by an automatically generated approximation of the original.

The special external model creation tool can be opened by right-clicking on
a selected component and choosing the ‘Thea Render/Create external
model/proxy’ option.

Creating an External Model

Gl Click on %he ‘From SketchUp’ button to obtain a thumbnail of an external model directly from
Create Thumbnail SketchUp. Or click the ‘Render’ button to start a new rendering using the current engine and

settings; it is recommended to choose one of the interactive rendering methods. Only a selection

will be rendered. To see a preview while the rendering is still running, click the ‘Render’ button

again; just a portion of the view will be shown. You can adjust the camera/sun position to achieve

the best look. When you are happy with the result, you can create proxies as described below.

Creating Proxies
To create a proxy from original components, select 'Detailed proxy.' Choose between Triangles or
Points, and specify the maximum number of triangles or
points. On the right is the original model containing about
27,000 faces. Just below are two proxies, each containing
only about 2,000 triangles or points.

[ From SketchUp ] [ From Thea l

Proxy Component Creation

/| Detailed proxy 200 If you only want to use the proxy in the current model,
@ Triangles () Points disable the ‘Save as .mod.skp’ option.

[¥] Save prowy as .mod.sk
i 3 As you can see in the bottom proxy on the right, the ‘Add

V] Add bounding box the bounding box’ option was enabled. To display only the
Replacement options bounding box, disable the ‘Detailed proxy’ option.

() Replace the instance . )
You can choose between replacing only the selection, or

@ Replace all instances .
all instances of the selected component.

R ] ’ G- ] When you click on ‘Save, you will choose where to save
the external model and, optionally, the proxy. All textures
associated with the component will be saved in the same

i 5
Create proxy component @ folder. - e R
Proxy Compenent Creation To create a proxy component from an existing Thea model,
[¥] Detailed proxy 200 right-click the thumbnail in the Thea Browser and choose
e s between triangles or points. When the ‘Detailed proxy’ Birch Tree 05 10mmod thea
@ Triangles () Points

option is enabled, you can add a bounding box if desired.

[¥] Add bounding box

’ Cancel ] ’ Save
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amera | Draw Tools Window Extensions Help

H H View [ Cam: I Wi
Proxy components can be also created manually in various — H P EB ez S
. L iy ¢ ¥
ways, but they have to be based on proxies that were created — = ,
using one of the two aforementioned methods. i e =
Pers; =
! e
Resolution
The following method works especially well for trees: it e P , W . s 0 0m
e Insert a mod.thea into an empty SketchUp model at the = : B oty
origin. Prjection
. . . . Shutter speed (motion blur) 250
e Switch to the front view and turn off the perspective view. ‘ St e Creslr S
e Select the Camera/Zoom tool so the entire height of the S
SketchUp view aligns with the proxy's bounding box. ' o
e Set the Thea camera to an ‘Arbitrary’ aspect ratio and adjust | : o an =
. |
the resolution so that the red camera frame matches the T = B
. . . i . < Distance (cm) 60
bounding box. The larger resolution (usually vertical) can be 512 - ‘ :cﬁpm
pixels | : [C]Near Distance 1.00
: | [7Far Distance. 1000.00
e In the ‘Channels’ tab, enable alpha channel and render the
model non-interactively in the Thea Window.
e Once you are satisfied with the rendering, save the image as a ‘ —— ‘
* png file. The alpha channel, responsible for transparency, will e
be saved automatically in this format. o
. . Scene Settings
* Repeat the same procedure for the side and top views. [ -]
[¥]Camera ] Sky/1BL

[]Display Rendler

This gives you three images, which you can then import to
SketchUp and place inside the proxy component. You can explode them (turn the images into editable geometry)
and delete the bounding box. Once you are happy with the result, you can right-click on the component and save it
in the same folder as original .mod.thea file.

CREATING PROXIES FROM FBX AND THEA MODELS

In Thea for SketchUp, it is possible to import FBX files and convert them to proxy models. While importing an FBX file, the user is able to
adjust the proxy materials.

e Start with a blank SketchUp model.

The proxy will be placed at 0,0,0 and it is better having a clean scene.

¢ Go to Extensions > Thea Render > Tools > Open FBX/Edit Thea Model

e Select an FBX file.

¢ Once loaded, the Proxy Creation dialog will popup which lets you adjust proxy settings.

e The list of materials in the drop-down of the Thea Material Editor will be populated with materials of the imported model. The list will
revert back to scene's material once it gets closed.

e Start Interactive Rendering and press the 'From Thea' button to grab a preview for the .mod.thea file that will be generated.

* Once done, click on the 'Save' button and select a location for the .mod.thea file. Better to save the file to the same location with all the
associated textures.

When Proxy Creation window closes — you will have a ready to render proxy inside SketchUp and corresponding .mod.thea on your HD.

[@a\t TBRBOHE ®

S Uniied- Sictchlp o 218
uuuuuuuuuuuuuuuuuuuuuuuuuuuu on Hep
NG /-l || _mers

®

XA
/S
HR
X
70

2]
q

O+
EL LA

o8 4 V%
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Start FBX / Thea Model conversion Material list of the imported model Creating a thumbnail with IR
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19. COPYRIGHT

Copyright of this manual belongs to Altair Engineering, Inc. 3ds max is copyright Autodesk, SketchUp is Trimble and CUDA is copyright
NVIDIA.

20. DISCLAIMER

“Thea for SketchUp” is provided “as-is” and without warranty of any kind, express, implied or otherwise, including without limitation, any
warranty of merchantability or fitness for a particular purpose. In no event shall the author of this software be held liable for data loss,
damages, loss of profits or any other kind of loss while using or misusing this software.

The software must not be modified, you may not decompile, disassemble. Any kind of reverse engineering of the software is prohibited.
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Material Preset Description

Resembles SketchUp material as
closely as possible. SketchUp
transparency is converted into
uniform alpha transparency.

DEFAULT

Produces a single-sided translucent
material, perfect for curtains and
other non-volumetric objects. You
can control the Transparency (%).

THIN
TRANSLUCENT

Represents a lacquered surface, like
the finish on hardwood floors.
Includes Reflections and Roughness
parameters. When Roughness is set
to 0, the material looks polished; at
higher values, it looks like satin.

LACQUER

This type describes a ceramic

CERAMIC material with a glossy finish.

The material using this preset will
resemble a car paint. When the
‘Metallic’ option is enabled, the

paint will behave as if it contained
uniformly spread metallic flakes.

CAR PAINT

This type is designed to give a metal
appearance with pronounced
reflections when the Roughness is
less than 10.

COLORED
METAL

Available Options Preview

Default Preset

Color

Reflections
Roughness

Bump

Thin Translucent Preset

l Caolor
Transparency 50 %
Bump 0% B .: ;":;5

Lacquer Preset

Color

Reflections
Roughness

Bump

Ceramic Preset

Color

Reflections

O —

Bump 0% e:r.: asl |

Car Paint Preset

Color

Reflections
[] Metallic
Bump

Colored Metal Preset

Color

Roughness

Bump
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Material Preset

MIRROR

THIN GLASS

GLASS

CLOUD

EMITTER

Description

Behaves like the surface of a mirror.
Overrides the SketchUp material
color.

An architectural glass. You can adjust
the Metallic reflections, which may
appear when coatings are added.
This material is especially well-suited
to nonsolid, thin faced objects.

Produces a volumetric glass that
takes into account refractions inside
the object. You can control the
surface's Roughness and the intensity
of the Reflections.

Cloud material preset for volumetric
effects defined by a solid group
component.

Turns a painted face into an emitter
of light, whose power can be
specified in different units. You can
use Temperature to adjust the color/
texture. You have the option to make
the emitter invisible in the rendering
or to make it “passive" (it will glow,
but won't cast direct light).

Available Options Preview

Mirror Preset

Bump

Thin Glass Preset

Color

Metallic Reflections
Bump

Glass Preset

Color

Reflections
Roughness

Bump

Cloud Preset

Coler

Emitter Preset

I Color .-@

4
Power 250,00 |Watts w7 !
[ Passive Emitter
[]Visible Emitter
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Network rendering requires a setup of connected computers in a local
network.

STARTING THEA NODE

Step 1.

Windows: Extract the zipped file to a folder. Browse to the Windows64
folder and double-click on the TheaNode.exe file.

MacOS: Open Terminal.app (usually located in Applications > Utilities).
Go into the \Mac64 folder using the "cd" command and press Enter.
You could also write "cd," add a space, and then drag the Mac64 folder
inside Terminal.

Then type ./TheaNode and press Enter.

Step 2.
Open SketchUp and from the Thea Rendering Window, switch to the
Rendering Tab and enable Network Rendering.

Network Rendering [v]

Server Mode Render and Manage =

Step 3.
Start rendering in Production Mode. The Network Tab in the Thea
Rendering Window will start showing all the render nodes.

There is no need to copy any asset for the render nodes to work
properly as this happens automatically.

The Thea Node tool does not need to be licensed to work properly.

" | E\users\s======\Projects\Releases\TheaNode\TheaNod... .= B X

/Projects/Relea

Altair Engineerin
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DOWNLOADING AND INSTALLING THEA LIBRARIES
Libraries can be downloaded by visiting the following link:
https://www.thearender.com/libraries/

The libraries that you will download are packed in zip format. Before proceeding to the installation, you need to first extract the .lib.thea
file. Once done, go to SketchUp and from the main menu, select:

Extensions > Thea Render > Tools > Install Library

A new window will pop up asking you to select the .lib.thea file you wish to install. Select the file and then click on 'Open'. More
information will be displayed in the next window asking you to check the 'Accept License Agreement' and click on the install icon on the
left.

After the installation has been completed, you will get a notification informing you about the path where the library has been installed.
The installer uses the Thea Data/Materials folder by default.

The new library can be accessed from the Thea Content Browser.

= —— = ™
& )=| | < 0ATAE) » Downiosss [ ¥ |[ search Dawnloads » — - lT
Organize v Newfolder By 0 @ Exterior Pavements N Library 'Exterior Pavements' has been successfuly installed in:

E\Thea Data.

7 Favorites

4 Libraries aterials/Exterior Pavements/4xd_wet_cobble_stone.mat.thea

18 Computer

@ Network I
Fiensme Bteiapovemenalivthes  +
. . ) ’ Solid Iris Technologies
Step 1: Select the .lib.thea file. LS siabiiin)
MName: Exterior Pavements
Author: Solid Iris Technologies
Version: 1.0
Description: A set of 14 unique high quality materials along with 10 i

close-up variations to dress your exterior architectural
pavements, with high reselution professional texture
maps, including displacement and bump. During

License: Thea Render, Plugins and Resources
End User License Agreement

l = 1

Accept License Agreement

Step 3: Confirmation dialog. Click Close.

Step 2: Accept the license and click on .
install.
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